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1. Introduction 

The Kindle Fire is the latest addition to Amazon’s Kindle family of devices. Unlike previous Kindle models, 

however, the Kindle Fire is the first device from Amazon to move beyond eBook reading by providing a full 

tablet experience with a multi-touch color screen and the ability to watch movies, read books and magazines, 

play music and install applications from the Amazon App Store. 

1.1 About Kindle Fire App Development Essentials 

The goal of this book is to teach the skills necessary to develop Android based applications for the Kindle Fire 

family of devices. 

Beginning with the basics, this book provides an outline of the steps necessary to set up an Android 

development environment. An introduction to the architecture of Android is followed by an in-depth look at 

the design of Android applications and user interfaces. More advanced topics such as database management, 

content providers and intents are also covered, as are touch screen handling, gesture recognition, camera 

access and the playback and recording of both video and audio.  

In addition to covering general Android development techniques, the book also includes Amazon and Kindle 

Fire specific topics such as creating Kindle Fire emulators for application testing, connecting Kindle Fire 

devices to the debugging environment, using the Amazon In-App Purchasing and Mobile Ads APIs, 

implementing maps using the Amazon Maps API and submitting apps to the Amazon Mobile App Distribution 

portal. 

Assuming you already have some Java programming experience, are ready to download Eclipse and the 

Android SDK, have access to a Windows, Mac or Linux system and ideas for some apps to develop, you are 

ready to get started.  

1.2 Downloading the Code Samples 

The source code and Eclipse project files for the examples contained in this book are available for download 

at: 

http://www.ebookfrenzy.com/code/kindlefire.zip 

Once the file has been downloaded and unzipped, the samples may be imported into an existing Eclipse 

workspace by selecting the Eclipse File -> Import… menu option and choosing the Android -> Existing Android 

Code Into Workspace category. When prompted, select the folder containing the sample project folders as 

the Root Directory before choosing the sample projects to be imported from the resulting list. 
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1.3 Feedback 

We want you to be satisfied with your purchase of this book. If you find any errors in the book, or have any 

comments, questions or concerns please contact us at feedback@ebookfrenzy.com. 

1.4 Errata 

Whilst we make every effort to ensure the accuracy of the content of this book, it is inevitable that a book 

covering a subject area of this size and complexity may include some errors and oversights. Any known issues 

with the book will be outlined, together with solutions, at the following URL: 

http://www.ebookfrenzy.com/errata/kindlefire.html 

In the event that you find an error not listed in the errata, please let us know by emailing our technical 

support team at feedback@ebookfrenzy.com. They are there to help you and will work to resolve any 

problems you may encounter. 

mailto:feedback@ebookfrenzy.com
http://www.ebookfrenzy.com/errata/kindlefire.html
mailto:feedback@ebookfrenzy.com
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2. An Overview of the Kindle Fire 

Amazon decided to enter the market for e-reader devices in 2004 with the formation of a hardware research 

and design division named A2Z Development Corp based in Palo Alto, California. The name originates from 

the Amazon.com logo, which incorporates an arrow in the shape of a smile swooping between the “A” and 

the “Z” in the company name (presumably intended to suggest that Amazon.com sells everything from A to 

Z). This secretive operation was later renamed “Lab126”, the letter “A”, of course, being the first letter of the 

alphabet and “Z” the 26th.  

The initial Kindle e-reader devices proved to be extremely successful and, within a few years, Amazon 

announced that eBooks had begun to outsell printed books in a variety of categories. In 2009, however, a 

threat appeared in the form of the iPad from Apple. Closely tied to Apple’s iTunes and iBooks stores, the iPad 

clearly posed a serious threat to Amazon’s dominance in digital goods, entertainment and services.  

Recognizing the tablet computer as a key gateway to controlling access to digital content, Lab126 began work 

on a project codenamed “Otter”. The results of the Otter project were made public on September 28, 2011 

when Amazon founder and CEO Jeff Bezos walked onto a stage in New York and announced the device that 

we now know as the Kindle Fire. 

2.1 Kindle Fire Operating System 

The operating system running on the first generation Kindle Fire was (and still is) based on Google’s Android 

2.3 (Gingerbread) mobile operating system. Though originally intended for use on smartphone devices, and 

superseded by more recent Android releases designed specifically for tablets, Amazon has heavily customized 

this older version of Android to meet the specific needs of the Kindle Fire user. The subsequent second 

generation Kindle Fire and more recent Kindle Fire HD models run an operating system that is currently based 

on Android 4.0.3. 

2.2 Kindle Fire, the Cloud and Pricing 

By just about any measure, the technical specifications of the first Kindle Fire were unremarkable. When 

compared to the iPad, for example, the absence of front and rear facing cameras, GPS, gyroscope, Bluetooth, 

3G connectivity and greater amounts of memory appeared to make the Kindle Fire seem uncompetitive. It 

should be noted, however, that this first Kindle Fire model was priced extremely aggressively ($199 in the 

United States).  

The feature gap between the Kindle Fire and the iPad has subsequently closed with the introduction of the 

Kindle HD 7” and HD 8.9” models. Pricing, on the other hand, has remained extremely competitive. In fact, it 

is estimated by industry analysts that Amazon has priced the devices so aggressively that the company 
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actually loses money on each sale. The goal, of course, is to reach a mass market of customers and generate 

revenue far in excess of that lost on the device by selling digital content from Amazon.com. 

In addition to the on-board storage, all digital content purchased through Amazon can be stored free of 

charge on Amazon’s cloud servers. This essentially means that there are is no limit to the amount of content 

that can be stored and accessed from a Kindle Fire as long as that content is purchased from Amazon and the 

device is connected to a Wi-Fi network. 

2.3 Summary 

Many tablet manufacturers have attempted to gain a competitive edge by relying on screen size, memory 

configuration, operating system versions and built-in hardware features. Instead of taking this approach, 

Amazon began by focusing on creating an affordable device that provided the functionality needed by the 

majority of users, and then integrated it with a vast catalog of digital content and potentially unlimited cloud 

storage. 

With the introduction of the latest Kindle Fire HD models, Amazon has begun to match many competing 

devices in terms of hardware features. The pricing, however, remains equally aggressive and no other tablet 

provider yet comes close to matching Amazon in terms of digital content.  

The Kindle Fire remains one of Amazon’s top selling products and was estimated at the start of 2012 to 

account for over 30% of the U.S. tablet market. Clearly, there is a large market waiting for any applications 

developed for the Kindle Fire. 
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3. Setting up a Kindle Fire Android 

Development Environment 

Before any work can begin on the development of an Android application for the Kindle Fire, the first step is 

to configure a computer system to act as the development platform. This involves a number of steps 

consisting of installing the Java Development Kit (JDK), the Eclipse Integrated Development Environment (IDE) 

and the appropriate Android Software Development Kit (SDK). In addition to these steps, it will also be 

necessary to install the Eclipse Android Development Tool (ADT) Plug-in. 

This chapter will cover the steps necessary to install the requisite components for Kindle Fire development on 

Windows, Mac OS X and Linux based systems. 

3.1 System Requirements 

Kindle Fire application development may be performed on any of the following system types: 

 Windows XP (32-bit) 

 Windows Vista (32-bit or 64-bit) 

 Windows 7 (32-bit or 64-bit) 

 Windows 8 

 Mac OS X 10.5.8 or later (Intel based systems only) 

 Linux systems with version 2.7 or later of GNU C Library (glibc) 

3.2 Installing the Java Development Kit (JDK) 

Both the Eclipse IDE and Android SDK were developed using the Java programming language. Similarly, 

Android applications written for the Kindle Fire are also developed using Java. As a result, the Java 

Development Kit (JDK) is the first component that must be installed. 

Kindle Fire development requires the installation of the Standard Edition of the Java Platform Development 

Kit version 6 or later. Java is provided in both development (JDK) and runtime (JRE) packages. For the 

purposes of Kindle Fire development, the JDK must be installed. 

3.2.1 Windows JDK Installation 

For Windows systems, the JDK may be obtained from Oracle Corporation’s website using the following URL: 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 
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Assuming that a suitable JDK is not already installed on your system, download the latest JDK package that 

matches the destination computer system. Note that although Oracle provides JDK packages for 32-bit 

(Windows x86) and 64-bit (Windows x64) systems, Amazon recommends use of the 32-bit download even 

when running a 64-bit version of Windows. Once downloaded, launch the installation executable and follow 

the on screen instructions to complete the installation process. 

3.2.2 Mac OS X JDK Installation 

The Java SE 6 environment or a more recent version should already be installed on the latest Mac OS X 

versions. To confirm the version that is installed, open a Terminal window and enter the following command: 

java -version 

Assuming that Java is currently installed, output similar to the following will appear in the terminal window: 

java version "1.6.0_37" 

Java(TM) SE Runtime Environment (build 1.6.0_37-b06-434-11M3909) 

Java HotSpot(TM) 64-Bit Server VM (build 20.12-b01-434, mixed mode) 

In the event that Java is not installed, issuing the “java” command in the terminal window should initiate the 

JDK installation process. 

3.2.3 Linux JDK Installation 

Firstly, if the chosen development system is running the 64-bit version of Ubuntu then it is essential that the 

32-bit library support package be installed: 

sudo apt-get install ia32-libs 

As with Windows based JDK installation, it is possible to install the JDK on Linux by downloading the 

appropriate package from the Oracle web site, the URL for which is as follows: 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 

Packages are provided by Oracle in RPM format (for installation on Red Hat Linux based systems such as Red 

Hat Enterprise Linux, Fedora and CentOS) and as a tar archive for other Linux distributions such as Ubuntu. 

On Red Hat based Linux systems, download the .rpm JDK file from the Oracle web site and perform the 

installation using the rpm command in a terminal window. Assuming, for example, that the downloaded JDK 

file was named jdk-7u10-linux-x64.rpm, the commands to perform the installation would read as follows: 

su 

rpm –ihv jdk-7u10-linux-x64.rpm 

To install using the compressed tar package (tar.gz) perform the following steps: 

1. Create the directory into which the JDK is to be installed (for the purposes of this example we will assume 

/home/demo/java). 

2. Download the appropriate tar.gz package from the Oracle web site into the directory. 

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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3. Execute the following command (where <jdk-file> is replaced by the name of the downloaded JDK file): 

tar xvfz  <jdk-file>.tar.gz 

4. Remove the downloaded tar.gz file. 

5. Add the path to the bin directory of the JDK installation to your $PATH variable. For example, assuming 

that the JDK ultimately installed into /home/demo/java/jdk1.7.0_10 the following would need to be added to 

your $PATH environment variable: 

/home/demo/java/jdk1.7.0_10/bin 

This can typically be achieved by adding a command to the .bashrc file in your home directory (specifics may 

differ depending on the particular Linux distribution in use). For example, change directory to your home 

directory, edit the .bashrc file contained therein and add the following line at the end of the file (modifying 

the path to match the location of the JDK on your system): 

export PATH=/home/demo/java/jdk1.7.0_10/bin:$PATH 

Having saved the change, future terminal sessions will include the JDK in the $PATH environment variable. 

3.3 Downloading the Android Developer Tools (ADT) Bundle 

Most of the work involved in developing applications for the Kindle Fire will be performed using the Eclipse 

Integrated Development Environment (IDE). If you are already using Eclipse to develop for other platforms, 

then the Android Developer Tools (ADT) plug-in can be integrated into your existing Eclipse installation (a 

topic covered later in this chapter). If, on the other hand, you are entirely new to Eclipse based development, 

the most convenient path to take is to install a package known as the ADT Bundle. This bundle includes many 

of the tools necessary to begin developing Android applications in a single download. 

The ADT Bundle may be downloaded from the following web page: 

https://developer.android.com/sdk/index.html 

From this page, either click on the download button if it lists the correct platform (for example on a Windows 

based web browser the button will read “Download the SDK ADT Bundle for Windows”), or select the 

“Download for Other Platforms” option to manually select the appropriate package for your platform and 

operating system. On the subsequent screen, accept the terms and conditions, the target architecture of 

your computer system (32-bit or 64-bit) and click on the download button. 

3.4 Installing the ADT Bundle 

The ADT Bundle is downloaded as a compressed ZIP archive file which must be unpacked to complete the 

installation process. The exact steps to achieve this differ depending on the operating system. 

3.4.1 Installation on Windows 

Locate the downloaded ADT Bundle zip file in a Windows Explorer window, right-click on it and select the 

Extract All… menu option. In the resulting dialog, choose a suitable location into which to unzip the file 

https://developer.android.com/sdk/index.html
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before clicking on the Extract button. When choosing a suitable location, keep in mind that the extraction will 

create a sub-folder in the chosen location named either adt-bundle-windows-x86 or adt-bundle-windows-

x86_64 containing the bundle packages. 

Once the extraction is complete, navigate in Windows Explorer to the directory containing the ADT bundle, 

move into the eclipse sub-folder and double click on the eclipse executable to start the Eclipse IDE 

environment. For easier future access, right click on the eclipse executable and select Pin to Taskbar from the 

resulting menu. 

It is possible that Windows will display a Security Warning dialog before Eclipse will launch stating that the 

publisher could not be verified. In the event that this warning appears, uncheck the “Always ask before 

opening this file” option before clicking the Run button. Once invoked, Eclipse will prompt for the location of 

the workspace. All projects will be stored by default into this folder. Browse for a suitable location, or choose 

the default offered by Eclipse and click on OK. 

3.4.2 Installation on Mac OS X 

On Mac OS X systems, open a terminal window, change directory to the location where Eclipse is to be 

installed and execute the following command: 

unzip /<path to package>/<package name>.zip 

For example, assuming a package file named adt-bundle-mac-x86_64.zip has been downloaded to 

/home/demo/Downloads, the following command would be needed to install Eclipse: 

unzip /home/demo/Downloads/adt-bundle-mac-x86_64.zip 

Note that the bundle will be installed into a sub-directory named adt-bundle-mac-x86_64. Assuming, 

therefore, that the above command was executed in /Users/demo, the software packages will be unpacked 

into /Users/demo/adt-bundle-mac-x86_64. Within this directory, the files comprising the Eclipse IDE are 

installed in a sub-directory named eclipse. 

Using the Finder tool, navigate to the eclipse sub-directory of the ADT bundle installation directory and 

double click on the eclipse executable to launch the application. For future easier access to the tool, simply 

drag the eclipse icon from the Finder window and drop it onto the dock. 

3.4.3 Installation on Linux 

On Linux systems, open a terminal window, change directory to the location where Eclipse is to be installed 

and execute the following command: 

unzip /<path to package>/<package name>.zip 

For example, assuming a package file named adt-bundle-linux-x86.zip has been downloaded to 

/home/demo/Downloads, the following command would be needed to install Eclipse: 

unzip /home/demo/Downloads/adt-bundle-linux-x86.zip 
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Note that the bundle will be installed into a sub-directory named either adt-bundle-linux-x86 or adt-bundle-

linux-x86_64 depending on whether the 32-bit or 64-bit edition was downloaded. Assuming, therefore, that 

the above command was executed in /home/demo, the software packages will be unpacked into 

/home/demo/adt-bundle-linux-x86. Within this directory, the files comprising the Eclipse IDE are installed in a 

sub-directory named eclipse. 

To launch Eclipse, open a terminal window, change directory to the eclipse sub-directory of the ADT bundle 

installation directory and execute the following command: 

./eclipse 

Once invoked, Eclipse will prompt for the location of the workspace. All projects will be stored by default into 

this folder. Browse for a suitable location, or choose the default offered by Eclipse and click on OK. 

Having verified that the Eclipse IDE is installed correctly, keep Eclipse running so that it can be used to install 

additional Android and Kindle specific SDK packages. 

3.5 Installing the Correct Android and Kindle Fire SDK Packages 

The steps performed so far have installed Java, the Eclipse IDE and the current set of default Android SDK 

packages. In order to develop applications for the Kindle Fire family of devices, particular versions of the 

Android SDK packages need to be installed along with some Kindle Fire specific SDK packages. This task can 

be performed using the Android SDK Manager, which may be launched from within the Eclipse tool by 

selecting the Window -> Android SDK Manager menu option. Once invoked, the SDK Manager tool will 

appear as illustrated in Figure 3-1: 

 

Figure 3-1 
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Once the SDK Manager is running, return to the main Eclipse window and select the File -> Exit menu option 

to exit from the Eclipse environment. This will leave the Android SDK Manager running whilst ensuring that 

the Eclipse session does not conflict with the installation process. 

Begin by checking that the SDK Path: setting at the top of the SDK Manager window matches the location 

into which the ADT Bundle package was unzipped. If it does not, relaunch Eclipse and select the Window -> 

Preferences option. In the Preferences dialog, select the Android option from the left hand panel and change 

the SDK Location setting so that it references the sdk sub-folder of the directory into which the ADT Bundle 

was unzipped before clicking on Apply followed by OK. 

The ultimate goal at this point is to download and install the SDK packages needed for Kindle Fire 

development. Most of these will be downloaded from the standard Google repository servers. A few 

packages, however, will need to be downloaded direct from Amazon. In order to make this possible, a new 

Add-on Site needs to be added to the list of sites in the manager. To achieve this, select the Tools -> Manage 

Add-on Sites menu option. In the resulting window, select the User Defined Sites tab as illustrated in Figure 

3-2: 

 

Figure 3-2 

Click on the New… button and enter the following URL into the resulting dialog: 

http://kindle-sdk.s3.amazonaws.com/addon.xml 

Click OK to close the dialog, make sure the URL is now listed under User Defined Sites and then click Close. 

The main SDK Manager window should now list Extras options to install the Kindle Fire Device Definitions and 

the Kindle Fire USB Driver packages. 

http://kindle-sdk.s3.amazonaws.com/addon.xml
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At the time of writing, Kindle Fire application development is performed using the Android 2.2.3 API Level 10 

and Android 4.0.3 API level 15 SDKs. The current versions supported by the Kindle Fire device family can be 

identified by referring to the following web page: 

https://developer.amazon.com/sdk/fire/setup.html 

For the purposes of this tutorial, the assumption is made that Android 4.0.3 is still the current release for 

newer Kindle Fire models. 

Within the Android SDK Manager, make sure that the check boxes next to the following packages are 

selected: 

 Tools > Android SDK Tools: Rev. 21 

 Tools > Android SDK Platform-tools: Rev. 16 

 SDK Platform Android 4.0.3 API 15 > SDK Platform 

 SDK Platform Android 4.0.3 API 15 > ARM EABI v7a System Image 

 SDK Platform Android 4.0.3 API 15 > Kindle Fire (2nd Generation) 

 SDK Platform Android 4.0.3 API 15 > Kindle Fire HD 7” 

 SDK Platform Android 4.0.3 API 15 > Kindle Fire HD 8.9” 

 SDK Platform Android 2.3.3 API 10 > SDK Platform 

 SDK Platform Android 2.3.3 API 10 > Kindle Fire 

 Extras > Kindle Fire USB Driver (Not applicable for Mac OS X or Linux.) 

 Extras > Kindle Fire Device Definitions 

 Extras > Android Support Library 

With the appropriate package selections made, click on the Install packages button to initiate the installation 

process. In the resulting dialog, accept the license agreements before clicking on the Install button. The SDK 

Manager will then begin to download and install the designated packages. As the installation proceeds, a 

progress bar will appear at the bottom of the manager window indicating the status of the installation as 

illustrated in Figure 3-3: 

https://developer.amazon.com/sdk/fire/setup.html
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Figure 3-3 

Once the installation is complete, review the package list and make sure that the selected packages are now 

listed as Installed in the Status column. If any are listed as Not installed (usually the Kindle Fire specific 

packages need to be installed separately from the generic Android packages), make sure they are selected 

and click on the Install packages… button again. 

3.6 Making the Android SDK Tools Command-line Accessible 

Most of the time, the underlying tools of the Android SDK will be accessed from within the Eclipse 

environment. That being said, however, there will also be instances where it will be useful to be able to 

invoke those tools from a command prompt or terminal window. In order for the operating system on which 

you are developing to be able to find these tools, it will be necessary to add them to the system’s PATH 

environment variable.  

Regardless of operating system, the PATH variable needs to be configured to include the following paths 

(where <path_to_adt_installation> represents the file system location into which the ADT bundle was 

installed): 

<path_to_adt_installation>/sdk/tools 

<path_to_adt_installation>/sdk/platform-tools 

The steps to achieve this are operating system dependent: 

3.6.1 Windows 7 

1. Right click on Computer in the desktop start menu and select Properties from the resulting menu. 

2. In the properties panel, select the Advanced System Settings link and, in the resulting dialog, click on the 

Environment Variables… button.  
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3. In the Environment Variables dialog, locate the Path variable in the System variables list, select it and 

click on Edit…. Locate the end of the current variable value string and append the path to the android 

platform tools to the end, using a semicolon to separate the path from the preceding values. For 

example, assuming the ADT bundle was installed into /Users/demo/adt-bundle-windows-x86_64, the 

following would be appended to the end of the current Path value: 

;C:\Users\demo\adt-bundle-windows-x86_64\sdk\platform-

tools;C:\Users\demo\adt-bundle-windows-x86_64\sdk\tools 

4. Click on OK in each dialog box and close the system properties control panel. 

Once the above steps are complete, verify that the path is correctly set by opening a Command Prompt 

window (Start -> All Programs -> Accessories -> Command Prompt) and at the prompt enter: 

echo %Path% 

The returned path variable value should include the paths to the Android SDK platform tools folders. Verify 

that the platform-tools  value is correct by attempting to run the adb tool as follows: 

adb 

The tool should output a list of command line options when executed.  

Similarly, check the tools path setting by attempting to launch the Android SDK Manager: 

android 

In the event that a message similar to following message appears for one or both of the commands, it is most 

likely that an incorrect path was appended to the Path environment variable: 

'adb' is not recognized as an internal or external command, 

operable program or batch file. 

3.6.2 Windows 8 

1. On the start screen, move the mouse to the bottom right hand corner of the screen and select Search 

from the resulting menu. In the search box, enter Control Panel. When the Control Panel icon appears in 

the results area, click on it to launch the tool on the desktop. 

2. Within the Control Panel, use the Category menu to change the display to Large Icons. From the list of 

icons select, the one labeled System. 

3. Follow the steps outlined for Windows 7 starting from step 2. 

3.6.3 Linux 

On Linux this will involve once again editing the .bashrc file. Assuming that the bundle package was installed 

into /home/demo/adt-bundle-linux-x86, the export line in the .bashrc file would now read as follows: 

export PATH=/home/demo/java/jdk1.7.0_10/bin:/home/demo/adt-bundle-linux-

x86/sdk/platform-tools:/home/demo/adt-bundle-linux-x86/sdk/tools:$PATH 
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3.6.4 Mac OS X 

A number of techniques may be employed to modify the $PATH environment variable on Mac OS X. Arguably 

the cleanest method is to add a new file in the /etc/paths.d directory containing the paths to be added to 

$PATH. Assuming an installation location of /Users/demo/adt-bundle-mac-x86_64, the path may be 

configured by creating a new file named android-sdk in the /etc/paths.d directory containing the following 

lines: 

/Users/demo/adt-bundle-mac-x86_64/sdk/tools 

/Users/demo/adt-bundle-mac-x86_64/sdk/platform-tools 

Note that since this is a system directory it will be necessary to use the sudo command when creating the file. 

For example: 

sudo vi /etc/paths.d/android-sdk 

3.7 Adding the ADT Plugin to an Existing Eclipse Integration 

The steps outlined so far in this chapter have assumed that the Eclipse IDE is not already installed on your 

system. In the event that you are already using Eclipse for Java based development, the appropriate Android 

development tools and SDKs can be added to this existing Eclipse installation. Eclipse editions with which the 

ADT Plugin is compatible are as follows: 

 Eclipse IDE for Java Developers 

 Eclipse Classic (versions 3.5.1 and higher) 

 Eclipse IDE for Java EE Developers 

 Eclipse for Mobile Developers 

The ADT Plugin for Eclipse adds a range of Android specific features to what is otherwise a general-purpose 

Java edition of the Eclipse environment. To install this plugin, launch Eclipse and select the Help –> Install 

New Software… menu option. In the resulting window, click on the Add… button to display the Add 

Repository dialog. Enter “ADT Plugin” into the Name field and the following URL into the Location field: 

https://dl-ssl.google.com/android/eclipse/ 

Click on the OK button and wait while Eclipse connects to the Android repository. Once the information has 

been downloaded, new items will be listed entitled Developer Tools and NDK Plugins as illustrated in Figure 

3-4: 
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Figure 3-4 

Select the checkbox next to the Developer Tools entry and click on the Next > button. After requirements and 

dependencies have been calculated by the installer, a more detailed list of the packages to be installed will 

appear. Once again click on the Next > button to proceed. On the subsequent licensing page, select the 

option to accept the terms of the agreements (assuming that you do, indeed, agree) and click on Finish to 

complete the installation. During the download and installation process, you may be prompted to confirm 

that you wish to install unsigned content. In the event that this happens, simply click on the option to 

proceed with the installation. 

When the ADT Plugin installation is complete, a dialog will appear providing the option to restart Eclipse in 

order to complete the installation. Click on Yes and wait for the tool to exit and re-launch. 

Upon restarting, the Welcome to Android Development dialog will appear as illustrated in Figure 3-5: 
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Figure 3-5 

At this stage there is no existing SDK installed so the Use Existing SDKs choice is not a viable option. 

Unfortunately, the ADT Plugin does not provide the option at this point to install the SDKs of our choice so we 

will need to install the latest available SDK versions and then manually install the ones we actually need for 

Kindle Fire development. With this in mind, select the option to install the latest available version of the 

Android APIs. Make a note of the Target Location path and change it if you prefer the SDKs to be installed in a 

different location, then click Next. Choose whether to send usage information to Google, accept all the 

licensing terms and click on Install. The Android SDK Manager will now download and install the latest 

Android SDKs. Once this process is complete, follow the steps outlined in the earlier section entitled Installing 

the Correct Android and Kindle SDK Packages to install the appropriate Android and Amazon packages for 

Kindle development.  

At this point, the Eclipse environment is ready to begin the development of Android applications for the 

Kindle Fire family of devices. 

3.8 Summary 

Prior to beginning the development of Android based applications for the Kindle Fire, the first step is to set 

up a suitable development environment. This consists of the Java Development Kit (JDK), Android and Kindle 

Fire SDKs, Eclipse IDE and the Android ADT Plugin for Eclipse. In this chapter, we have covered the steps 

necessary to install these packages on Windows, Mac OS X and Linux. 



 

17 

 

 

 

4. Creating a Kindle Fire Android Virtual 

Device (AVD) 

In the course of developing Android apps for the Kindle Fire it will be necessary to compile and run an 

application multiple times. An Android application for the Kindle Fire may be tested by installing and running 

it either on a physical device or in an Android Virtual Device (AVD) emulator environment. Before an AVD can 

be used, it must first be created and configured to match the specification of a Kindle Fire model. The goal of 

this chapter, therefore, is to work through the steps involved in creating such a virtual device. 

4.1 About Android Virtual Devices 

AVDs are essentially emulators that allow Android applications to be tested without the necessity to install 

the application on a physical Android based device. An AVD may be configured to emulate a variety of 

hardware features including options such as screen size, memory capacity and the presence or otherwise of 

features such as a camera, GPS navigation support or an accelerometer. As part of the installation process 

outlined in the previous chapter, a number of emulator definitions were installed allowing AVDs to be 

configured for the current range of Kindle Fire devices. 

When launched, a Kindle Fire specific AVD will appear as a window containing an emulated Kindle Fire device 

environment. Figure 4-1, for example, shows an AVD session configured to emulate the Kindle Fire HD 7” 

device: 

Chapter 4 
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Figure 4-1 

New AVDs are created and managed using the Android Virtual Device Manager, which may be used either in 

command-line mode or with a more user-friendly graphical user interface. 

4.2 Creating a Kindle Fire AVD 

In order to test the behavior of an application on the full range of Kindle Fire devices it will be necessary to 

create an AVD for each device configuration. At time of writing this consists of Kindle Fire (1st Generation), 

Kindle Fire (2nd Generation), Kindle Fire HD 7” and Kindle Fire HD 8.9” devices. For the purposes of this 

chapter, an AVD will be created configured to emulate the Kindle Fire HD 7” device. 

In order to create a new AVD, the first step is to launch the AVD Manager. This can be achieved from within 

the Eclipse environment using the Window -> Android Virtual Device Manager menu option. Alternatively, 

the tool may be launched from the command-line using the following command: 

android avd 

Once launched, the tool will appear as outlined in Figure 4-2. Assuming a new Android SDK installation, no 

AVDs will currently be listed: 
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Figure 4-2 

Begin the AVD creation process by clicking on the New… button in order to invoke the Create a New Android 

Virtual Device (AVD) dialog. Within the dialog, perform the following steps to create a Kindle Fire compatible 

emulator: 

1. Enter a descriptive name (for example KindleFireHD7) into the name field. Note that spaces and other 

special characters are not permitted in the name. 

2. Set the Device menu to Kindle Fire HD 7” (800 x 1280: hdpi). 

3. Use the Target menu to select the option matching the Device setting, in this case the Kindle Fire HD 7” 

(Amazon) – API Level 15 target. 

4. Set the CPU/ABI menu to ARM (armeabi-v7a). 

5. Leave the default RAM value in Memory Options. 

6. The VM Heap value should be set to 64MB for the Kindle Fire – 1st Generation and to 256MB for the 

Kindle Fire – 2nd Generation and Kindle Fire HD models. 

7. Set Internal Storage to 1024 MiB. 

8. If the host computer contains a web cam the Front Camera: emulation may be configured to use this 

camera. Alternatively, an emulated camera may be selected. If camera functionality is not required by 

the application, simply leave this set to None. 

Whether or not you enable the Hardware Keyboard and Display skin with hardware controls options is 

optional.  When the hardware keyboard option is selected, it will be possible to use the physical keyboard on 

the system on which the emulator is running. As such, the Kindle software keyboard will not appear within 

the emulator.  

The skin with hardware controls option controls whether or not buttons appear as part of the emulator to 

simulate the hardware buttons present on the sides of the physical Kindle Fire device. 
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Note that it may also be possible to speed the performance of the emulator by enabling the Use Host GPU 

option. In the event that the emulator crashes during startup when this option is selected, edit the virtual 

device properties and disable this option. 

Figure 4-3 illustrates the dialog with the appropriate settings implemented for a Kindle Fire HD 7” emulator. 

Once the configuration settings are complete, click on the OK button. 

 

Figure 4-3 

With the AVD created, the AVD Manager may now be closed. If future modifications to the AVD are 

necessary, simply re-open the AVD Manager, select the AVD from the list and click on the Edit… button. 

4.3 Starting the Emulator 

To perform a test run of the newly created AVD emulator, simply select the emulator from the Android 

Virtual Device Manager and click on the Start… button followed by Launch in the resulting Launch Options 

dialog. The emulator will appear in a new window and, after a short period of time, the “kindle fire” text will 

appear in the center of the screen. The first time the emulator is run, it can take up to 10 minutes for the 

emulator to fully load and start. On subsequent invocations, this will typically reduce to a few minutes. In the 

event that the startup time on your system is considerable, do not hesitate to leave the emulator running. 
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The ADT system will detect that it is already running and attach to it when applications are launched, thereby 

saving considerable amounts of startup time.  

Once fully loaded, the emulator will display either the standard Kindle Fire lock screen, or the home screen 

showing a small selection of pre-installed applications as previously shown in Figure 4-1.  

4.4 Kindle Fire AVD Command-line Creation 

As previously discussed, in addition to the graphical user interface it is also possible to create a new AVD 

directly from the command-line. This is achieved using the android tool in conjunction with some command-

line options. Once initiated, the tool will prompt for additional information before creating the new AVD.  

Assuming that the system has been configured such that the Android SDK tools directory is included in the 

PATH environment variable, a list of available targets for the new AVD may be obtained by issuing the 

following command in a terminal or command window: 

android list targets 

The resulting output from the above command will contain a list of Android SDK versions that are available 

on the system. For example: 

Available Android targets: 

---------- 

id: 1 or "android-10" 

     Name: Android 2.3.3 

     Type: Platform 

     API level: 10 

     Revision: 2 

     Skins: HVGA, QVGA, WQVGA400, WQVGA432, WVGA800 (default), WVGA854 

     ABIs : armeabi 

---------- 

id: 2 or "Amazon:Kindle Fire:10" 

     Name: Kindle Fire 

     Type: Add-On 

     Vendor: Amazon 

     Revision: 3 

     Description: Android SDK Add-On for Kindle Fire 

     Based on Android 2.3.3 (API level 10) 

     Skins: WVGA854, WQVGA400, HVGA, KindleFire (default), WQVGA432, 

WVGA800, QVGA 

     ABIs : armeabi 

     Adds USB support for devices (Vendor: 0x1949) 

---------- 

id: 3 or "android-15" 

     Name: Android 4.0.3 

     Type: Platform 

     API level: 15 

     Revision: 3 
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     Skins: HVGA, QVGA, WQVGA400, WQVGA432, WSVGA, WVGA800 (default), 

WVGA854, WXGA720, WXGA800 

     ABIs : armeabi-v7a 

---------- 

id: 4 or "Amazon:Kindle Fire (2nd Generation):15" 

     Name: Kindle Fire (2nd Generation) 

     Type: Add-On 

     Vendor: Amazon 

     Revision: 2 

     Description: Android SDK Add-On for Kindle Fire (2nd Generation) 

     Based on Android 4.0.3 (API level 15) 

     Skins: WVGA854, WQVGA400, WSVGA, WXGA720, HVGA, KindleFire (default), 

WQVGA432, WVGA800, QVGA, WXGA800 

     ABIs : armeabi-v7a 

     Adds USB support for devices (Vendor: 0x1949) 

---------- 

id: 5 or "Amazon:Kindle Fire HD 7":15" 

     Name: Kindle Fire HD 7" 

     Type: Add-On 

     Vendor: Amazon 

     Revision: 2 

     Description: Android SDK Add-On for Kindle Fire HD 7" 

     Based on Android 4.0.3 (API level 15) 

     Skins: WVGA854, WQVGA400, WSVGA, WXGA720, HVGA, KindleFire (default), 

WQVGA432, WVGA800, QVGA, WXGA800 

     ABIs : armeabi-v7a 

     Adds USB support for devices (Vendor: 0x1949) 

---------- 

id: 6 or "Amazon:Kindle Fire HD 8.9":15" 

     Name: Kindle Fire HD 8.9" 

     Type: Add-On 

     Vendor: Amazon 

     Revision: 3 

     Description: Android SDK Add-On for Kindle Fire HD 8.9" 

     Based on Android 4.0.3 (API level 15) 

     Skins: WVGA854, WQVGA400, WSVGA, WXGA720, HVGA, KindleFire (default), 

WQVGA432, WVGA800, QVGA, WXGA800 

     ABIs : armeabi-v7a 

     Adds USB support for devices (Vendor: 0x1949) 

---------- 

The syntax for AVD creation is as follows: 

android create avd -n <name> -t <targetID> [-<option> <value>] 

For example, to create a new AVD named KindleFireHD89 using the target id for the Kindle Fire HD 8.9” 

device (in this case id 6), the following command may be used: 

android create avd -n KindleFireHD89 -t 6 
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The android tool will create the new AVD to the specifications required for a Kindle Fire HD 8.9” device. Once 

a new AVD has been created from the command line, it may not show up in the Android Device Manager tool 

until the Refresh button is clicked. 

In addition to the creation of new AVDs, a number of other tasks may be performed from the command line. 

For example, a list of currently available AVDs may be obtained using the list avd command line arguments: 

android list avd 

 

Available Android Virtual Devices: 

    Name: KindleFireHD7 

    Path: C:\Users\nas\.android\avd\KindleFireHD7.avd 

  Target: Kindle Fire HD 7" (Amazon) 

          Based on Android 4.0.3 (API level 15) 

     ABI: armeabi-v7a 

    Skin: 800x1280 

--------- 

    Name: KindleFireHD89 

    Path: C:\Users\nas\.android\avd\KindleFireHD89.avd 

  Target: Kindle Fire HD 8.9" (Amazon) 

          Based on Android 4.0.3 (API level 15) 

     ABI: armeabi-v7a 

    Skin: 1200x1920 

Similarly, to delete an existing AVD, simply use the delete option as follows: 

android delete avd –name <avd name> 

4.5 Android Virtual Device Configuration Files 

By default, the files associated with an AVD are stored in the .android/avd sub-directory of the user’s home 

directory, the structure of which is as follows (where <avd name> is replaced by the name assigned to the 

AVD): 

<avd name>.avd/config.ini 

<avd name>.avd/userdata.img 

<avd name>.ini 

The config.ini file contains the device configuration settings such as display dimensions and memory specified 

during the AVD creation process. These settings may be changed directly within the configuration file and will 

be adopted by the AVD when it is next invoked. 

The <avd name>.ini file contains a reference to the target Android SDK and the path to the AVD files. Note 

that a change to the image.sysdir value in the config.ini file will also need to be reflected in the target value 

of this file.  
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4.6 Moving and Renaming an Android Virtual Device 

The current name or the location of the AVD files may be altered from the command line using the android 

tool’s move avd argument. For example, to rename an AVD named KindleFire2 to KindleFire3, the following 

command may be executed: 

android move avd -n KindleFire2 -r KindleFire3 

To physically relocate the files associated with the AVD, the following command syntax should be used: 

android move avd -n <avd name> -p <path to new location> 

For example, to move an AVD from its current file system location to /tmp/KindleFireTest: 

android move avd -n KindleFire2 -p /tmp/KindleFireTest 

Note that the destination directory must not already exist prior to executing the command to move an AVD. 

4.7 Summary 

A typical application development process follows a cycle of coding, compiling and running in a test 

environment. Android applications may be tested on either a physical Kindle Fire device or using an Android 

Virtual Device (AVD) emulator. AVDs are created and managed using the Android AVD Manager tool which 

may be used either as a command line tool or using a graphical user interface. When creating an AVD to 

simulate the Kindle Fire it is important that the virtual device be configured with a hardware specification 

that matches that of the physical device.  

Now that we have created and configured an AVD, the next step is to create a simple application and run it 

within the AVD. 
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5. Creating an Example Kindle Fire 

Android Application 

The preceding chapters of this book have covered the steps necessary to configure an environment suitable 

for the development of Kindle Fire based Android applications. Before moving on to slightly more advanced 

topics, now is a good time to validate that all of the required development packages are installed and 

functioning correctly. The best way to achieve this goal is to create a simple Android application, compile it 

and then run it within an Android Virtual Device (AVD) configured as a Kindle Fire emulator. 

5.1 Creating a New Android Project 

The first step in the application development process is to create a new project within the Eclipse IDE. Begin, 

therefore, by launching Eclipse and accepting the default path to your workspace in the Workspace Launcher 

dialog as illustrated in Figure 5-1 (or choose another location if the default is unsuitable). Note that if you do 

not wish to be prompted for the location of the workspace each time Eclipse loads, simply select the Use this 

as the default and do not ask again option before clicking on OK. 

 

Figure 5-1 

Once the workspace has been selected, the main Eclipse workbench window will appear ready for a new 

project to be created. To create the new project, select the File -> New -> Android Application Project… menu 

option.  

5.2 Defining the Project Name and SDK Settings 

In the New Android Project window set both the Application Name and Project Name to KindleTest. 

The Package Name is used to uniquely identify the application within the Android application ecosystem. It 

should be based on the reversed URL of your domain name followed by the name of the application. For 

Chapter 5 
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example, if your domain is www.mycompany.com, and the application has been named KindleTest, then the 

package name might be specified as: 

com.mycompany.kindletest 

If you do not have a domain name, you may also use example.com for the purposes of testing, though this 

will need to be changed before an application can be published: 

com.example.kindletest 

The next step is to specify some SDK settings. Since the first generation Kindle Fire ran a variant of Android 

2.2, the Minimum Required SDK menu should be set to API 8:Android 2.2 (Froyo). The Target SDK and Compile 

With menus should be set to API 17: Android 4.2 (Jelly Bean). Once these settings have been configured, the 

dialog should match that shown in Figure 5-2: 

 

Figure 5-2 

5.3 Project Configuration Settings 

With the correct settings configured, click Next >  to proceed to the Configure Project screen (Figure 5-3). 

Within this screen, a number of different configuration options are provided.  

Make sure that the Create Activity and Create customer launcher icon options are selected. The former 

setting will ensure that the project is preconfigured with a template activity that will make the task of 

creating an example application easier. An activity is a single task that can be performed by the user within 

the context of an application and is typically analogous to a single user interface screen within an application. 

In asking for Eclipse to create an activity for us, therefore, the project will be primed with both a window 
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onto which a user interface may be displayed and the code to ensure that the window appears when the 

application runs. 

The custom launcher selection, on the other hand, will provide the option to specify the icon that will 

represent the application on the device screen.   

 

Figure 5-3 

5.4 Configuring the Launcher Icon 

Clicking the Next > button will proceed to the launcher icon configuration screen. Before the application can 

be submitted to the Kindle Fire app store for sale it will need to have an icon associated with it. This icon is 

displayed on the screen of the Kindle Fire device and is touched by the user to launch the application. The 

launch icon can take the form of a set of PNG image files, clipart or even text. Options are also provided on 

this screen to configure the background color of the launcher and to change the shape surrounding the icon. 

When assigning image files for the launcher icon, images for a variety of screen resolutions and densities may 

be specified. If only a single image size is provided, the Android system will scale the image for different 

screens, potentially leading to some image quality degradation. For the purposes of this example, however, it 

is adequate to use the default icon images: 
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Figure 5-4 

Click Next > to proceed with the configuration process. 

5.5 Creating an Activity 

The next step is to define the type of initial activity that is to be created for the application. A range of 

different activity types is available when developing Android applications, though many of these are not 

available for the earlier version of Android used by the first generation Kindle Fire. For the purposes of this 

example, however, simply select the option to create a BlankActivity before clicking Next >. 



Creating an Example Kindle Fire Android Application 

29 

 

Figure 5-5 

With the Blank Activity option selected, click Next >. On the final screen (Figure 5-6) name the activity 

KindleTestActivity. The activity will consist of a single user interface screen layout which, for the purposes of 

this example, should be named activity_kindle_test. Finally, since this is a very simple, single screen activity, 

there is no need to select a navigation type, so leave this menu set to None (as with the activity options, 

these settings are not supported for the older release of Android on the first generation Kindle Fire): 

 

Figure 5-6 

Finally, click on Finish to initiate the project creation process.  

5.6 Running the Application in the AVD 

At this point, Eclipse has created a minimal example application project and opened the main workbench 

screen. If the “Welcome!” panel is still displayed, close it by clicking on the “X” in the “Android IDE” tab. 
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The newly created project and references to associated files are listed in the Package Explorer located in a 

panel on the left hand side of the main Eclipse window. Clicking on the right facing arrow next to the 

KindleTest project name will unfold the project and list the various files and sub-folders contained therein. 

This essentially mirrors the directory hierarchy and files located in the project’s workspace folder on the local 

file system of the development computer: 

 

Figure 5-7 

The example project created for us when we selected the option to create an activity consists of a user 

interface containing a label that will read “Hello World” when the application is executed. In order to run the 

application in the AVD that was created in the chapter entitled Creating a Kindle Fire Android Virtual Device 

(AVD), simply right-click on the application name in the Package Explorer and select Run As -> Android 

Application from the resulting menu. If, at this point, more than one AVD emulator has been configured on 

the system, a window will appear providing the option to select which AVD environment the application will 

run in. If multiple AVDs are listed, select the Kindle Fire emulator created in the earlier chapter. In the event 

that only one AVD is available, Eclipse will automatically launch that virtual device. The AVD window typically 

appears immediately, but a delay may be encountered as the emulator starts up and loads the Android 

operating system. Once the operating system has loaded, the example application will run and appear within 

the emulator as shown in Figure 5-8: 
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Figure 5-8 

In the event that the activity does not automatically launch, check to see if the launch icon has appeared on 

the emulator screen. If it has, simply click on it to launch the application. 

When the application has launched, an additional window may appear asking whether or not LogCat 

messages should be monitored. When an application is running, a range of diagnostic messages is output by 

the system. In addition, the application developer may have included diagnostic messages into the 

application code. It is generally recommended, therefore, that monitoring of these messages be enabled. 

Assuming that the application loads into the emulator and runs as expected, we have safely verified that the 

Android development environment is correctly installed and configured. 

5.7 Stopping a Running Application 

When building and running an application for testing purposes, each time a new revision of the application is 

compiled and run, the previous instance of the application running on the device or emulator will be 

terminated automatically and replaced with the new version. It is also possible to manually stop a running 

application from within the Eclipse environment.  

To stop a running application, begin by displaying the Eclipse DDMS perspective (DDMS stands for Dalvik 

Debug Monitor Server). The default configuration for Eclipse is to launch showing the Java perspective and 

for a button to be located in the top right hand corner of the main Eclipse screen (Figure 5-9) that allows the 

DDMS perspective to be displayed. 
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Figure 5-9 

In the event that this button is not present, the perspective may be displayed using the Window -> Open 

Perspective -> DDMS menu option. Once selected, the DDMS perspective will appear as illustrated in (Figure 

5-10). 

 

Figure 5-10 

The left hand panel, entitled devices, lists any devices or emulators to which the development environment is 

attached. Under each device is a list of processes currently running on that device or emulator instance. 

Figure 5-11, for example, shows the Devices panel with the KindleTest application running: 
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Figure 5-11 

To terminate the KindleTest application, select the process from the list and click on the red Stop button 

located in the Device panel toolbar. 

To return to the main Java development perspective, simply click on the Java button in the Eclipse toolbar. 

5.8 Modifying the Example Application 

The next step in this tutorial is to modify the user interface of our application so that it displays a larger text 

view object with a different message to the one provided for us by Eclipse.  

The user interface design for our activity is stored in a file named activity_kindle_test.xml which, in turn, is 

located under res -> layout in the project workspace. Using the Package Explorer panel, locate this file as 

illustrated in Figure 5-12: 
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Figure 5-12 

Once located, double click on the file to load it into the user interface builder tool which, in turn, will appear 

in the center panel of the Eclipse main window: 
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Figure 5-13 

In the toolbar across the top of the layout editor panel is a menu that is currently set to Nexus One. Since we 

are designing a layout for the screen of a Kindle Fire device, change this menu to one of the Kindle Fire 

options. For example, click on the menu and select the Amazon -> Kindle Fire HD 7” (800 x 1280: hdpi) menu 

option. The visual representation of the device screen will subsequently change to reflect the dimensions of 

the Kindle Fire HD 7” device. To change the orientation between landscape and portrait simply use the drop 

down menu immediately to the right of the device selection menu showing the  icon. 

In the center of the panel is the graphical representation of the user interface design, now within the context 

of the Kindle Fire HD 7” device. As can be seen, this includes the label that displays the Hello World message. 

Running down the left hand side of the panel is a palette containing different categories of user interface 

components that may be used to construct a user interface, such as buttons, labels and text fields. It should 

be noted, however, that not all user interface components are obviously visible to the user. One such 

category consists of layouts. Android supports a variety of different layouts that provide different levels of 

control over how visual user interface components are positioned and managed on the screen. Though it is 

difficult to tell from looking at the visual representation of the user interface, the current design has been 

created using a RelativeLayout. This can be confirmed by reviewing the information in the Outline panel that, 

by default, is located on the upper right hand side of the Eclipse main window and is shown in Figure 5-14: 



Creating an Example Kindle Fire Android Application 

36 

 

Figure 5-14 

As we can see from the outline, the user interface consists of a RelativeLayout parent that has as a child the 

TextView object. 

The first step in modifying the application is to delete the TextView component from the design. Begin by 

clicking on the TextView object within the user interface view so that it appears with a blue border around it. 

Once selected, press the Delete key on the keyboard.  

From the Palette panel, select the Form Widgets category if it is not already selected. Click and drag the Large 

TextView object and drop it in the center of the user interface design (green marker lines will appear to 

indicate the center of the display): 

 

Figure 5-15 
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Right-click over the TextView and select Edit Text… from the menu. When developing applications, attributes 

and values such as text strings should be stored in the form of resources wherever possible. Doing so enables 

changes to the appearance of the application to be made by modifying resource files instead of changing the 

application source code. This can be especially valuable when translating a user interface to a different 

spoken language. If all of the text in a user interface is contained in a single resource file, for example, that 

file can be given to a translator who will then perform the translations and return the translated file for 

inclusion in the application. This enables multiple languages to be targeted  without the necessity for any 

source code changes to be made. In this instance, we are going to create a new resource named 

welcomestring and assign the string “Welcome to the Kindle Fire” to it. In the Resource Chooser dialog that is 

currently displayed, click on the New String… button and in the resulting Create New Android String dialog 

enter “Welcome to the Kindle Fire” into the String field and welcomestring into the New R.string field before 

clicking on OK. On returning to the Resource Chooser, make sure welcomestring is selected before clicking on 

OK. 

Once changes have been made to a file within Eclipse, it is important to remember to save the changes 

before moving on to other tasks. This can be achieved by selecting the File -> Save menu option, or by using 

the Ctrl-S keyboard shortcut. Eclipse also allows multiple files to be open for editing simultaneously. Each 

open file is represented by a tab along the top edge of the editing panel. To close an open file, simply click on 

the X next to the file name in the corresponding tab.  

When there is insufficient space to display a tab for each open file, a >> symbol appears to the far right of the 

tab bar together with a number indicating the number of open files beyond those currently visible. Clicking 

on this will display a dropdown list of all open files. Figure 5-16, for example, shows tabs for three currently 

open files together with an indication that another seven files are open but not visible. The drop down menu 

shows the names of all ten open files: 
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Figure 5-16 

Double clicking on a tab will cause that editing session to expand to fill the entire Eclipse window. Double 

clicking a second time reverts the panel to its original size. Clicking and dragging a tab outside the Eclipse 

window results in the editing session for the corresponding file appearing in an entirely separate window on 

the desktop. 

Editing panels may be displayed side by side in a tiled arrangement by clicking and dragging a tab to a 

location to the right or left of, or above or below an existing editing panel. As the dragging motion 

approaches different locations, guidelines will appear indicating whether the editing panels will be tiled 

vertically or horizontally.  

The design is now complete so once again run the application in the emulator environment. This time the 

larger TextView will appear in the center of the display containing the new string resource value. 

5.9 Reviewing the Layout and Resource Files 

Before moving on to the next chapter, we are going to look at some of the internal aspects of user interface 

designs and resource handling. In the previous section, we made some changes to the user interface by 

modifying the activity_kindle_test.xml file using the Graphical Layout tool. In fact, all that the Graphical 

Layout was doing was providing a user-friendly way to edit the underlying XML content of the file. In practice, 

there is no reason why you cannot modify the XML directly in order to make user interface changes, and in 

some instances, this will actually be quicker than using the graphical layout tool. At the bottom of the 

Graphical Layout  panel are two tabs labeled Graphical Layout and activity_kindle_test.xml respectively. To 

switch to the XML view simply select the activity_kindle_test.xml tab as shown in Figure 5-17: 
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Figure 5-17 

As can be seen from the structure of the XML file, the user interface consists of the RelativeLayout 

component, which in turn, is the parent of the TextView object. We can also see that the text property of the 

TextView is set to our welcomestring resource. Although varying in complexity and content, all user interface 

layouts are structured in this hierarchical, XML based way.  

Finally, use the Package Explorer to locate the res -> values -> strings.xml file and double click on it to load it 

into the editor. Tabs at the bottom of the editor pane provide options to use the resource editor (Resources) 

or to view the raw XML content of the file (strings.xml). Currently the XML should read as follows: 

<?xml version="1.0" encoding="utf-8"?> 

<resources> 

    <string name="app_name">KindleTest</string> 

    <string name="hello_world">Hello world!</string> 

    <string name="menu_settings">Settings</string> 

    <string name="welcomestring">Welcome to the Kindle Fire</string> 

</resources>  

As a demonstration of resources in action, change the string value currently assigned to the welcomestring 

resource then run the application again. Note that the application has picked up the new resource value for 

the welcome string.  

5.10 Summary 

Whilst not excessively complex, a number of steps are involved in setting up an Android development 

environment for the Kindle Fire. Having performed those steps, it is worth working through a simple example 

to make sure the environment is correctly installed and configured. In this chapter, we have created an 

application and then run it within a Kindle Fire AVD emulation environment. The Eclipse Graphical Layout tool 
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was then used to modify the user interface of the application. In so doing, we explored the importance of 

using resources wherever possible, particularly in the case of string values, and briefly touched on the topic 

of layouts. Finally, we looked at the underlying XML that is used to store the user interface designs of Android 

applications.  

Now that we have looked at running applications within an AVD emulator environment, the next chapter will 

cover testing Android applications on a physical Kindle Fire device. 
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6. Testing Android Applications on a 

Physical Kindle Fire Device with ADB 

Whilst much can be achieved by testing applications using an Android Virtual Device (AVD) there is no 

substitute for performing real world application testing on a physical Kindle Fire device.  

Communication with both AVD instances and connected Android devices such as the Kindle Fire is handled by 

the Android Debug Bridge (ADB). In this chapter we will work through the steps to configure the adb 

environment to enable application testing on a Kindle Fire device on Mac OS X, Windows and Linux based 

systems. 

6.1 An Overview of the Android Debug Bridge (ADB) 

The primary purpose of the ADB is to facilitate interaction between the development system and both AVD 

emulators and physical Android devices for the purposes of running and debugging applications. 

The ADB consists of a client, a server process running in the background on the development system and a 

daemon background process running in either AVDs or physical Android devices such as the Kindle Fire.  

The ADB client can take a variety of forms. For example, a client is provided in the form of a command-line 

tool named adb located in the Android SDK platform-tools sub-directory. Similarly, the Eclipse ADT Plugin also 

has a built-in client. 

A variety of tasks may be performed using the adb command-line tool. For example, a listing of currently 

active virtual or physical devices may be obtained using the devices command-line argument. The following 

command output indicates the presence of an AVD on the system but no physical devices: 

$ adb devices 

List of devices attached 

emulator-5554   device 

6.2 Enabling ADB on the Kindle Fire Device 

Before ADB can connect to a Kindle Fire device, that device must first be configured to allow the connection. 

On the first generation Kindle Fire device this is enabled by default. On all other Kindle Fire models, go to the 

device settings screen, select Security and set Enable ADB to On. 

Chapter 6 


	1. Introduction
	1.1 About Kindle Fire App Development Essentials
	1.2 Downloading the Code Samples
	1.3 Feedback
	1.4 Errata

	2. An Overview of the Kindle Fire
	2.1 Kindle Fire Operating System
	2.2 Kindle Fire, the Cloud and Pricing
	2.3 Summary

	3. Setting up a Kindle Fire Android Development Environment
	3.1 System Requirements
	3.2 Installing the Java Development Kit (JDK)
	3.2.1 Windows JDK Installation
	3.2.2 Mac OS X JDK Installation
	3.2.3 Linux JDK Installation

	3.3 Downloading the Android Developer Tools (ADT) Bundle
	3.4 Installing the ADT Bundle
	3.4.1 Installation on Windows
	3.4.2 Installation on Mac OS X
	3.4.3 Installation on Linux

	3.5 Installing the Correct Android and Kindle Fire SDK Packages
	3.6 Making the Android SDK Tools Command-line Accessible
	3.6.1 Windows 7
	3.6.2 Windows 8
	3.6.3 Linux
	3.6.4 Mac OS X

	3.7 Adding the ADT Plugin to an Existing Eclipse Integration
	3.8 Summary

	4. Creating a Kindle Fire Android Virtual Device (AVD)
	4.1 About Android Virtual Devices
	4.2 Creating a Kindle Fire AVD
	4.3 Starting the Emulator
	4.4 Kindle Fire AVD Command-line Creation
	4.5 Android Virtual Device Configuration Files
	4.6 Moving and Renaming an Android Virtual Device
	4.7 Summary

	5. Creating an Example Kindle Fire Android Application
	5.1 Creating a New Android Project
	5.2 Defining the Project Name and SDK Settings
	5.3 Project Configuration Settings
	5.4 Configuring the Launcher Icon
	5.5 Creating an Activity
	5.6 Running the Application in the AVD
	5.7 Stopping a Running Application
	5.8 Modifying the Example Application
	5.9 Reviewing the Layout and Resource Files
	5.10 Summary

	6. Testing Android Applications on a Physical Kindle Fire Device with ADB
	6.1 An Overview of the Android Debug Bridge (ADB)
	6.2 Enabling ADB on the Kindle Fire Device


